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Internetist üldisemalt 
 
Internet sai alguse 1960. aastal USA-s sõjaväeasutuste ja teaduskeskuste  suurarvutite vahelisest 
andmesidevõrgust ARPANET.  

80-ndatel aastatel liitus ARPA-ga tuhandeid teadusasutusi ja ülikoole ning töötati välja Gopheri-
nimeline täiustatud failiteisaldusvahend, mis oli varustatud oma teabeotsisüsteemiga. See oli 
määratud peamiselt tekstiinfo edastamiseks üksteisest eemalasuvate arvutite vahel.  

Oluline muutus saabus 80-ndate aastate lõpus, kui Genfis asuvas Euroopa Tuumauuringute Keskuse 
CERN-i uurimislaboris hakati arendama uut süsteemi, et edastada jooniseid sisaldavaid dokumente, 
samuti sisaldasid need viiteid teistele samasugustele dokumentidele. Selle süsteemi aluseks võeti uus 
loodav hüpertekstikeel HTML (HyperText Markup Language). See võimaldas ühes dokumendis 
kirjeldada lisaks tekstile ka graafikat, heli ja videot, samuti kasutada selles erikujulisi viiteid teistele 
samataolistele dokumentidele, mida hakati nimetama hüperlinkideks (hüperviitadeks). 

Eriti tormiline Interneti kasutuse tõus toimus kogu maailmas 1990. aastail, selle kümnendi algul 
ühines Internetiga ka Eesti. 

Internet on lai mõiste, tähendades tegelikult võrkude võrku — paljusid väga erineva suuruse ja 
struktuuriga, üle maailma laiali pillatud arvutikooslusi, mis on kindlate reeglite ja vahendite abil 
üksteisega ühendatud ning võimaldavad info liikumist ühest osavõrgust teise.  

 

 

 

Internet ei tähenda ainult sellist arvutitest koosnevat võrku, vaid ka informatsiooni, mis on selles 
võrgus ja mis on kättesaadav kõigile, kes läbi oma arvuti internetiga ühenduses on.  

Internetis sisalduv info on tihti korrastamata, ja seda stiihiliselt arenevat ja tsensuurita süsteemi ei 
kontrolli otseselt ükski riigiamet ega eraorganisatsioon. Internetis tihti liigub ringi palju juhuslikke, 
tarbetuid ja isegi ebasoovitavaid materjale. 

  



Interneti baaskursus                                   

 4 

 

 
Netikett ehk võrgu etikett 

Võrgus on aja jooksul välja kujunenud terve hulk reegleid, nn. netikett (netiquette) ehk võrgu etikett. 
Iga Interneti kasutaja peaks nendest reeglitest kinni pidama — sellega austate Te teisi Interneti 
kasutajaid.  
 
Kõigepealt kehtivad WWW-s täielikult kõik Interneti üldised etiketinõuded — mida võib kokku võtta 
lausesse "ära tee seda, mida ei taha, et sulle tehakse". Igasugune mõnitamine, halvustamine, 
sõimamine ning ropendamine mõjub WWW-s täpselt sama räigena kui mistahes muul kujul. 
 
Veel mõned reeglid/soovitused: 

 olge ettevaatlik autorikaitseseadusega kaitstud materjalide kasutamise ja tsiteerimisega; 

 lugege julgesti KKK-artikleid (Korduma Kippuvad Küsimused) ehk inglise keeles FAQ-artikleid 
(Frequently Asked Questions). Kindlasti leiate sealt vastused enamusele teid huvitavatele 
küsimustele! 

 võrgus võrdub SUURTE tähtedega kirjutamine KARJUMISEGA; 

 ärge saatke faile (dokumente, pilte, programme jms) sinna kus neid ei oodata. 
 
Internetis suheldes vestluskaaslane ei näe teie näoilmet ja kui tahate vaid nalja teha, ei pruugi lugeja 
teid mõista. Siin tulevad appi emotikonid ehk smailid (smiley) – märgikombinatsioonid, mis annavad 
edasi emotsioone: 
 
 
 
 
 
 
 
 
 
 
Et kiiremini suhelda, on kasutusele võetud ka väga palju lühendeid. Siin kohal mõne näite lühike 
„seletav sõnastik“: 
 
 
 
 
 

 
 
 
 
 

 
 
  

 
: -)    või   : )     - tähistab naeratus, rõõmsat meelt 
: -(    või   : (     - kurbust 
; -)    või   ; )     - itsitust, kavalat silmapilgutust 
 
 

 

 ASAP (as soon as possible) – nii ruttu kui võimalik 

 IMHO (in my humble opinion) – minu tagasihoidliku arvamuse 
kohaselt 

 LOL (laughing out loud) – valju häälega naerdes 

 A/S/L? (age, sex, location?) – vanus, sugu, elukoht? 

 BRB (be right back) – olen kohe tagasi 

 FAQ (frequently asked questions) – korduma kippuvad küsimused 
(KKK) 

 FYI (for your information) – teie teadmiseks 
 



Interneti baaskursus                                   

 5 

 
 
Aadressid Internetis 
 
Igale Internetti ühendatud arvutile antakse kindel aadress, mille järgi teda leida võib nagu kortereid-
maju tavaliste postiaadresside järgi. Arvutid leiavad teisi arvuteid numbrilise IP-aadressi järgi – 
näiteks 194.126.101.67. Kuna aga inimesel on numbreid raskem meeles pidada, on aadressid 
praktikas dubleeritud nimedega, näiteks seesama arvuti (194.126.101.67) on ka www.neti.ee 
 
Igal dokumendil on Internetis ka oma aadress ehk URL (Universal Resource Locator) -veebilehekülje 
aadress. Dokumendile viidatakse URL abil, mis määrab, millises arvutis dokument asub ja kus kohas 
ta selles arvutis paikneb. Aadress koosneb mitmest osast, näiteks: 
 

http://www.regionaalhaigla.ee/dokumendid/avaldus.doc 

 

1. http:// (HyperText Transfer Protocol)  - pöördusmeetod (ehk protokoll) – määrab, et 

otsitakse veebilehekülge 

2. www.regionaalhaigla.ee – arvuti nimi (serveri nimi) 

3. dokumendid -  kataloogi nimi, kus asuvad failid 

4. avaldus.doc – dokumendi (faili) nimi 

 

Arvuti aadressi viimane osa tähistab harilikult riiki, kus arvuti asub. Eestit näitavad tähed <ee>, 
Soomet <fi>, Rootsit <se> ja nii edasi – igal riigil maailmas on oma aadressilühend ehk domeen. 

Internetis kasutatavad mõned domeeninimed:  

 .ee - Eesti 
 .ru  - Venemaa 
 .no - Norra 
 .de - Saksamaa 
 .com - äriühingud 
 .edu - haridusasutused 
 .gov - riigiasutused 
 .mil - sõjaväeasutused 
 .net - suured võrgukeskused 
 .org - ülejäänud organisatsioonid 

  

http://www.neti.ee/
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Veebilehitseja ehk Brauser (Internet Explorer 7.0) 
 
Veebilehitseja ehk brauser on arvutiprogramm, mis toob sinuni Internetis leiduvad leheküljed. 
Interneti lehitsemiseks on olemas erinevaid programme (Opera, Mozilla FireFox, Netscape Navigator 
ja muud). Kõige populaarsem brauser on Internet Explorer.  
 
Programmi käivitamiseks tuleb:  
 

1. kas klõpsata enamasti küll igas arvutis töölauale toodud ikoon Internet Explorer 
 

 
Internet Explorer 
 

2. või valida Start menüüst Programs ja selles leitud real Internet Explorer hiirega 
klõpsata. 

 
 
 
Internet Exploreri aken koosneb tiitelribast, aadressiribast, menüüribast ja tööriistaribast: 
 
 
 
 
 

 
 
 
 
 
 
Tiitelriba näitab hetkel lahtioleva veebilehe nime ning mis programmi antud hetkel kasutatakse. 
 
Menüüriba – siin on rühmitatud käsklused ning funktsioonid vastavate pealkirjade alla. 
 
Aadressiriba - aadressiaknas on esialgselt kodulehekülje aadress. Selle saab aga väljalt kustutada ja 
asendada see klaviatuurilt uue aadressi tippimisega.  
 
Tööriistariba – siin asuvad töönupud. 

  

tiitelriba aadressiriba 

tööriistariba menüüriba avatud leht uus leht 
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Kuidas Internetis liikuda? 
 
Hüperlingid 

 
Internetilehekülgedel on hüperlingid ehk lingid. Hüperlink on elektrooniline tekst, mis sisaldab 
viitasid (linke) teistes arvutites paiknevatele tekstidele. Viidaks võivad olla lehekülje suvalised osad 
(lause, sõna, pilt vms). 
 
Enamasti on veebilehtedel üks või rohkem linki, millel klõpsamine viib sind edasi järgmisele 
veebilehele. Tavaliselt tuleb sul linkidega edasi liikuda siis, kui sa ei tea otsitava veebilehe täpset 
aadressi või kui uurid mingi lehekülje sisu. 
 
Kuna veebilehtedel on erinev sisu ja kujundus, näevad ka nende lingid erinevad välja. Sõnad on 
hüperlingis teist värvi ja alla joonitud. Kui liigud mööda veebilehte hiirega, siis seal, kus on hüperlink, 
muudab kursor oma kuju: 

    
„Käpp“ (osutav sõrm) tähendab, et tegu on lingiga, mis avaneb, kui sellel klõpsata. 

 
Nool on hiirekursori tavaline „osutamise“ kuju, mida kasutatakse veebilehel liikumiseks 
 

I 
 
Kui kursor muutub selliseks, saab sellesse kohta tippida teksti. 
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Aadressid ja aadressiriba kasutamine 
 
Kui tead selle koha täpset aadressi, mida tahad vaadata, võid selle kirjutada otse aadressiribale 
järgmiselt: 
 

1. Märgista olemasolev aadress seda klõpsates 

2. Tipi aadressiribale uus aadress, nt www.regionaalhaigla.ee 

3. Vajuta Enter klaviatuurilt 

 
Sinu arvuti ekraanile ilmub nüüd Põhja-Eesti Regionaalhaigla koduleht. Aadressi algususse pole vaja 

kirjutada protokolli <http://>, sest Internet Explorer lähtub sellest, et soovid otsida mingit veebilehte, 

mis kasutab seda protokollinime. Isegi www-d pole sageli vaja tippida, kui aadress nii algab – sellegi 

„aimab“ brauser ise ära ja lisab omalt poolt. 

 
 

  

 
NB! Pea meeles, et <ä>, <ö>, <õ> ja <ü> tähte Internetiaadressides ei kasutata, samuti ei 
ole aadressides tühikuid. 
 

 
 

 
 
Kõik kasutatud aadressid salvestatakse ja esinevad aadressvälja rippmenüüs, kust saab neid uuesti 
kasutada nende ridadel klõpsates: 
 
 

 
 
 

 

http://www.regionaalhaigla.ee/
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Internet Exploreri peamised nupud 

Veebilehtede vahetamiseks, info otsimiseks või akna sisu värskendamiseks võid kasutada 
brauseriakna tööriistariba nuppe: 

 

 

 

 

 

 

 

 
 

 
   

Back- viib tagasi 

eelmisele lehele 

Forward – viib 

sellele lehele, mis 
oli avatud enne 
Back vajutamist 

Refresh – 

uuendab 
lehte 

Stop –peatab 

lehe avamise ehk 
allalaadimise 

Home – 

viib 
avalehele 

Aadressiriba. Siia võib 

kirjutada uue aadressi ja 
vajutada Enter 

Favorites – 

sinu 
lemmiklehed 

Uus leht – 

avab uue lehe 
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Internet Exploreri avalehe muutmine 
 
Standardina kasutatakse avalehena Microsoft kodulehekülge (Eestis – www.neti.ee),  kuid sa võid 
valida selleks suvalise veebilehe, nt oma lemmikotsingumootori. 
 

1. Vali menüüst Tools-> Internet Options-> General vahekaart 
2. Kirjuta oma avalehe aadress Home page kasti (nt www.google.ee)  
3. Vajuta OK 

 
 

 
 
 
  

 

http://www.neti.ee/
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Teeme lemmikute kausta (Favorites) 
 
Et vajalikud ja huvitavad veebilehed ka edaspidi üles leida, saab need oma lemmikutesse 
(järjehoidjatesse) lisada ning edaspidi sealt avada neid lehti.  
 

1. Kui oled oma lemmikleheküljel ja soovid seda salvestada „Lemmiklehekülgede“ kausta, vali 

nupuribalt kollane täht plussiga Add to Favorites (lisada lemmikutesse) -> Avaneb 
menüü Add to Favorites 

 

 
 

2. Reale Name: sisesta nimi, mida tahad lemmikule omistada, et hiljem seda nimekirjast kiiresti 
leida.  

3. Lemmiku lisamisel saad valida ka kausta, kuhu lemmik paigutatakse -> selleks klõpsa nupul 

Create in ja vali kaust. 

4. Nupuga New Folder saad luua uue kausta lemmikute jaoks 

5. Kinnita oma salvestamissoovi ja klõpsa hiirega nupul Add 

 
Kui soovid oma lemmiklehekülge külastada, ava menüü Favorites ja klõpsa lehekülje nimel, mida 
soovid avada 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Favorites 

Lemmiklehekülgede 
loetelu 
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Teie külastatud veebilehtede ajaloo kustutamine 
 
Vaikimisi Internet Explorer säilitab kõikide teie külastatud veebilehtede ajaloo. Külastatud 
veebilehtede ajaloo kustutamiseks valige Tools->Internet options->General  
 
Jaotises Browsing history klõpsake käsku Delete (kustuta ajalugu) ning avanenud  aknas nuppu 
Delete history, et kinnitada  oma soov ajaloo  kustutamiseks. 
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Teksti suuruse määramine 
 
 
Kui sul on raske veebilehtedel väikest kirja lugeda, saad teksti suurust muuta. 
 
Selleks vali View-> Text Size ja klõpsa soovitud suurust (kus Largest on  kõige suurem, ja Smallest  
kõige väiksem suurus) 
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Brauseri omaduste muutmine: ajutiste Interneti-failide kustutamine 
 
Temporary Files – ajutised interneti failid, nn „puhver“, kus hoitakse külastatud veebisaitide sisu, 

mida saab offline režiimis vaadata. Võimaluse korral kuvatakse dokumendid Interneti asemel alati 

puhvrist. Nupuga Delete Files saab puhvri tühjendada. Puhvris hoitakse kõiki vaadeldud dokumente 

ja sinna koguneb tuhandeid faile, millest paljud on kasutud, kui sa sama veebisaiti korduvalt ei 

külasta. Seepärast võiks puhvri aeg-ajalt tühjendada. Vaikimisi kasutatakse puhvriks 10% kõvaketta 

mahust. 
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Automaatteksti ajaloo kustutamine 
 
Automaattekst teeb sisendpaneelis ettepanekuid teksti (nt otsingusõnade ja paroolide) kiiremaks 
sisestamiseks. Internet Explorer säilitab teabe, mille sisestate otsingureale ja paroolid, mida kasutate 
veebisaitidele sisse logimiseks. Privaatsuse kaitsmiseks järgige selle teabe kustutamiseks järgnevaid. 
 
Paroolide kustutamine 
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Otsingusõnade kustutamine  ehk  Delete forms 
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Otsing Internetis 
 
Teabeotsing Internetis muutub iga aasta üha keerukamaks ja aegaviitvamaks. Samal ajal kui veebi 
maht kahekordistub iga 6-8 kuuga, suudavad otsisüsteemid  katta sellest üha väiksem osa. 
Võrguotsingute hõlbustamiseks on välja töötatud palju uusi meetodeid ja otsivahendeid, millest 
allpool on toodud lühike ülevaate. 
 
Veebis kasutusel kahte tüüpi otsiaparaate: kataloogiotsing ja märksõnaotsing. 
 
Kataloogiotsingul on aluseks teema nimetus (temaatika) ja seda kasutatakse kindla märksõna 
puudumisel. Otsing toimub teemade järgi hierarhiliselt, alates üldteemast ja seejärel kitsenedes 
 
Märksõnaotsingu korral antakse otsiprogrammile (otsingumootorile)  ette otsitavat materjali 
lähemalt iseloomustav märksõna või fraas. Programm sirvib välkkiirelt läbi tohutu materjali, mis 
leidub Internetis. Järgnevalt toob teabeotsiteenus ekraanile loetelu leitud materjalide kohta. Eeliseks 
on palju suurema andmebaasi olemasolu kui eelmisel juhul, kuid puuduseks suure arvu 
ühtelangevate vastuste teke, millest paljudel pole otsitavaga mingit seost.  

 
Tavaliselt otsingusüsteemid kombineerivad mõlemat meetodit.  
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Kataloogid 
 
Kataloogides on suur osa tööst juba ette ära tehtud: leheküljed on kvaliteetsed ja temaatilises 
järjekorras nagu tavalises raamatukogus.  Teemaindeksites saad nagu raamatukoguski „riiulitelt 
otsida“ enne mingi kindla „raamatu“ välja valimist. Võid uurida erinevaid teemasid/ kategooriaid ja 
võib olla ei peagi sa eraldi teemaindeksis otsingut kasutama, sest võid leida otsitava lihtsalt sind 
huvitavaid teemasid „lehitsedes“. Vastavaid linke klõpsates jõuad sa sageli otsitava veebileheni. 
Enamik katalooge pakub ka otsinguvõimalust, et leiaksid hõlpsamalt vajaliku koha.  
 
 
Kõige tuntumad temaatilised kataloogid on praegu Eestis... 
  

 www.neti.ee 

 www.ee 

 www.infoweb.ee 
 

 
 
ning maailmas... 

 

 Yahoo  www.yahoo.com 
 
  

http://www.neti.ee/
http://www.ee/
http://www.infoweb.ee/
http://www.yahoo.com/
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Märksõnaotsing 

 
Otsingumootor (search engine) on arvutiprogramm, mis oskab lugeda teksti ja jälgida veebilehtedel 
olevaid linke. Arvutiprogrammid, mida kutsutakse “ämblikuteks” (ingl. spider), käivad pidevalt 
internetilehekülgedel ja korjavad neist sõnu, moodustades nii märksõnastiku. Iga märksõna juurde 
lisatakse antud sõna sisaldanud lehekülgede aadressid. Kui sisestada otsingumootorisse märksõna, ei 
hakata sel hetkel läbi otsima Internetiaadresse, vaid otsitakse koostatud märksõnastikust ja 
väljastatakse vastusena aadressid, mis olid lisatud antud märksõna juurde. Päringu tulemus antakse 
linkidena nendele aadressidele. 
 
Otsingumootorid sisaldavad kataloogidest palju enam viiteid. Vastukaaluks pole kvaliteedinõuded nii 
kõrged, sest otsinguprogrammid ei ole nii täiuslikud, et suudaksid hinnata veebilehe kvaliteeti sama 
hästi kui inimene. 
 
 
Levinuimad otsivahendid: Märksõnaotsing 
 

 Google www.google.com  

 Yahoo http://search.yahoo.com/web 

 Live Search  www.live.com/  

 MSN  www.msn.com  

 AltaVista www.altavista.com  

 Search.com www.search.com 

 Ask www.ask.com  

 AOL NetFind www.netfind.com 

 Neti www.neti.ee  

 Yandex: www.yandex.ru  
 

 

 

  

http://www.google.com/
http://search.yahoo.com/web
http://www.live.com/
http://www.msn.com/
http://www.altavista.com/
http://www.search.com/
http://www.ask.com/
http://www.netfind.com/
http://www.neti.ee/
http://www.yandex.ru/
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Otsingumootor  GOOGLE 
 
Google on interneti üks suurimatest „mootoritest” - eelmisest aastast pärit uuringu kohaselt on 
Google käes 54 % internetiotsingutest - ehk pea pool.  
 
 

 

 
 
Google otsingumootori kasutamiseks tuleb kirjutada aadressiribale aasdress www.google.ee ja 
klõpsata klahvi Enter 
 
 
 
 

 

Google
54%

Yahoo
20%

MSN/Windows 
Live
13%

AOL
5%

Ask.com
2%

My Web Search
1%

Teised
5%

Täpsem otsing 

Korraldab pildi 
otsinguid 

Korraldab teksti 
otsinguid 

Siia kirjuta otsingu 
märksõna 

http://searchenginewatch.com/showPage.html?page=2156451
http://www.google.ee/
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Lihtpäring 
 

Näiteks otsing sõna "Tallinn" järgi annab nimekirja kõikidest otsisüsteemis registreeritud 
lehekülgedest, mis sisaldavad seda märksõna, - mingit infot Eesti pealinna kohta. Kuna mitmed 
otsisüsteemid sisaldavad oma baasis infot kümne või isegi mitmekümne miljoni eri lehekülje kohta, 
hõlmates sellega olulisema osa kogu Internetis avalikult kättesaadavast infost, toimub sõna „Tallinn“ 
otsing tegelikult üle kogu maailma.  

Päringute tulemused väljastatakse tavaliselt nimekirjana, kus leitud leheküljed (viited neile) on 
järjestatud otsitava(te) sõna(de) esinemisrohkuse järjekorras.  

 

 
Nimekiri edastatakse kliendile tavaliselt kümne või mõnekümne ühiku kaupa; selle läbi vaadanud, 
saab siirduda järgmistele viidetele, mis langevad kokku juba väiksema tõenäosusega. 
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Leitud dokumentide relevantsuse hindamine 
 
Google kuulub uue põlvkonna otsimootorite hulka, kus veebilehe tähtsuse määramisel kasutatakse 
paljusid lisafaktoreid, mida teised otsisüsteemid ei tee. Peamisteks nende hulgas on sagedus, millega 
teised veebisaidid vaadeldavale saidile viitavad ja kui üldtuntud nimetatud saidid ise on. Sellele 
vaatamata on otsisüsteemid suhteliselt rumalad, kuna need pole võimelised saama aru teksti sisust, 
vaid otsivad sõnu või tekstiosi mehaaniliselt. Tavaline on olukord, kus mingit  konkreetset teemat 
otsides saadakse vastuseks tohutu hulk viiteid, millest enamik on kasutud. Seepärast tuleb kõigepealt 
osata formuleerida võrdlemisi mõistlik päring, mis ei haara endaga kaasa igasugust "prahti". Ning ka 
siis tuleb olla valmis vaatama läbi tihti sadu kodulehekülgi, millest parimal juhul vaid üks või mõni 
vastab sisu poolest otsija konkreetsetele lootustele. Seega nõuab efektiivne otsing Internetis 
mõningaid vilumusi ja kogemusi.  
 
Otsingu tulemusena saate kindlasti ka mitteasjakohaseid (mitterelevantseid) dokumente. See on 
paratamatu.  Ideaaljuhul sooviksite saada ainult relevantseid dokumente.  Leitud dokumentide 
relevantsust saate hinnata, vaadates pealkirja, võtmesõnu ja sisukokkuvõtet. Kui viimane puudub, on 
päris raske hinnata, kas tegemist on relevantse dokumendiga. Mõnikord selgub see alles siis, kui käes 
on ka täistekst. 
 
 
Mõned näpunäited 

 Vaadake leitud relevantsetele dokumentidele lisatud märksõnu, samuti võite leida 
dokumentide kirjetest või täistekstist olulisi sõnu, mida otsingule lisada.  

 Vaadake leitud relevantsete dokumentide kasutatud kirjanduse nimekirja, ehk on seal mõni, 
mida tahaksite ise lugeda.  

 Mõelge, milliseid otsingumootoried saate veel kasutada.  
 Piirake otsingut sisukokkuvõtte või pealkirja väljaga, nii saate relevantsemad tulemused, sest 

olulised sisu kirjeldavad sõnad peaksid enamasti pealkirjas või sisukokkuvõttes esinema 
 Kasutage sünonüüme 
 Kasutage erinevaid sõnavorme 
 Ärge kasutage liiga tavalisi sõnu 
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Fraasiotsing 
 
Otsitakse mingi kindlat väljendit või lauset sisaldavaid dokumente. Päringu esitamisel tuleb otsitav 
fraas panna jutumärkidesse. Sellisel juhul otsitakse dokumente, kus märksõnad asuvad kõrvuti ja 
samas järjekorras. 
 
Näiteks:  "mina olen inimene" 
Leitakse dokumendid, kus on täpselt selline fraas. 
 

 

 
 
Metamärgi kasutamine 
 
Saate fraasi otsimiseks kasutada metamärke - (*) vastab suvalisele sõnale.   
Näiteks:   „* ja poliitika”  otsib kõiki sõnu ja sõnavorme fraasis 
 
„ajalugu ja poliitika“ 
„ühiskond ja poliitika“ 
„naised ja poliitika“ 
„majandus ja poliitika" 
jne. 

 

http://www.google.com/search?hl=en&safe=off&q=%22*+over+troubled+water%22
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Google täpsem otsing  

 
Failide otsimine 

Google võimaldab otsida vasteid ainult määratud tüüpi dokumentidest!  Näiteks,  stress filetype:doc 
otsib sõnu stressi  kohta ainult Microsoft Word’i dokumentidest.  

 

 
Googlis toetatud on järgmised failiformaadid: pdf, ps, wk1, wk2, wk3, wk4, wk5, wki, wks, wku, lwp, 
mw, xls, ppt, doc, wks, wps, wdb, wri, rtf, swf, ans, txt, xml, cpp, java. 

Mis tähendavad need formaadid?  

*.doc; *.rtf – MS Word tekstidokument 

*.ppt; *.pps – MS PowerPoint presentatsioon 

*.xls – MS Excel tabel 

*.pdf - Acrobat Reader (tekstidokumendid, raamatud, jaotusmaterjalid) 

*.zip - Winzip arhiivid 

*.exe - see on iseseisev programm, vaja salvestada ja siis käivitada. Võib olla ka mingi programmi 
installeerimispakett.  

*.jpg - pildid, mis avanevad brauseris endas (ei vaja tarkvara)  
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*.avi; *.mpg - video, peaks töötama korralikult häälestatud Internetis.  

*.mp3; *.wav - muusika failid, peaks olema kuulatavad hea häälestuse korral.  

 

Otsingu laiendamine  
 

 
 
 
„Vähemalt ühega neist sõnadest“ laiendab otsingut: leitavates dokumentides peab esinema kas üks 
või teine (või mõlemad) päringus ühendatud sõnadest. 
 
Näiteks: 
 
turism reisimine– leitakse artiklid, kus esinevad ainult turism, ainult reisimine, või nii turism kui ka 
reisimine 
 
Reale „vähemalt ühega neist sõnadest“ on otstarbekas kirjutada... 
 
1. sünonüüme: õppur õppija 
2. erineva kirjaviisiga sõnu: organization organisation 
3. sarnase tähendusega /seotud sõnu ja fraase: turism reisimine 
 
 

Otsingu kitsendamine  
 

 

„Ilma sõnadeta“ kitsendab otsingut, esimene sõna peab esinema, teine ei tohi esineda. Nii saab 
välistada mõne sõna esinemist leitavates artiklites.  
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Näiteks: 

Turism -reklaam- leitakse dokumendid, kus esineb sõna „turism“, kuid jäetakse välja dokumendid, 
kus esineb sõna „reklaam“. 

lemmikloom -madu – leitakse leheküljed, kus esineb sõna “lemmikloom”, kuid jäetakse välja 
aadressid, kus esineb ka sõna “madu”. 

 
 

Google kalkulaator 
 
Google Calculator on üks meeldivamaid lahendusi - see võimaldab mitte ainult teha küllaltki 
keerukaid matemaatilisi tehteid, vaid ka konverteerida erinevate mõõtühikute vahel - näiteks 30 
feet in meters, 451F in C. 
 
Näited 

 
 
 
 
 
 

 

 

 

 

 

  

Operaator  Example  

+ 3+44  

-  13-5 

*  7*8 

/  12/3 

^ 8^2 

% of  20% of 150  

2 USD in EEK valuuta konvirteerimine 

http://www.google.com/search?hl=en&safe=off&q=30+feet+in+meters&btnG=Search
http://www.google.com/search?hl=en&safe=off&q=30+feet+in+meters&btnG=Search
http://www.google.com/search?hl=en&safe=off&q=451F+in+C&btnG=Search
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Teadusinformatsiooni otsinguks sobivad otsingumootorid  
 
scholar.google.com 

www.scirus.com 

infomine.ucr.edu 

www.intute.ac.uk 

 
 
Meditsiinilised otsingumootorid ja teemakataloogid 
 
www.hon.ch/MedHunt  

www.ncbi.nlm.nih.gov/PubMed  

www.medweb.emory.edu 

www.netdoctor.co.uk  

www.kliinikum.ee/infokeskus  

Kasulikud  www-aadressid 
 

maps.google.com/maps  Kohaotsingumootor 

www.youtube.com  Videolõikude otsing 

translate.google.com  Tõlkimisteenus 

babelfish.altavista.com/  Tõlkimisteenus  

www.keeleveeb.ee  Erinevad sõnastikud 

www.ase.ee/dict  Vene-eesti-vene on-line sõnastik 

ester.nlib.ee Eesti Raamatukogude Elektronkataloog 

www.utlib.ee   Tartu Ülikooli raamatukogu 

www.riigiteataja.ee  Õigusaktide andmebaas   

estlex.ee/estlex/index.jsp  Õigusaktide andmebaas   

www.shareware.com  (tarkvara otsing) 

www.sm.ee   Sotsiaalministeerium 

www.stat.ee Statistikaamet 

www.kutsekoda.ee   Kutseregister ja kutsestandardid 

www.tak.ee  Tallinna Autobussikoondis (sõiduplaanid) 

www.ebay.com  Ostuotsing (ing.k) 

www.shareware.com  Tarkvara otsing (ing.k) 

http://www.scirus.com/
http://www.intute.ac.uk/
http://www.hon.ch/MedHunt
http://www.ncbi.nlm.nih.gov/PubMed
http://www.medweb.emory.edu/
http://www.netdoctor.co.uk/
http://www.kliinikum.ee/infokeskus
http://maps.google.com/maps
http://www.youtube.com/
http://translate.google.com/
http://babelfish.altavista.com/
http://www.keeleveeb.ee/
http://www.ase.ee/dict
http://ester.nlib.ee/
http://www.utlib.ee/
http://www.riigiteataja.ee/
http://estlex.ee/estlex/index.jsp
http://www.shareware.com/
http://www.sm.ee/
http://www.stat.ee/
http://www.kutsekoda.ee/
http://www.tak.ee/
http://www.ebay.com/
http://www.shareware.com/
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Internetilehelt materjali salvestamine 
 

Failide salvestamine Internetist 
 
Palju infot on internetis failidena, mida saab endale salvestada. Klõpsates hiire parema klahviga lingil, 
mis viitab failile, valige kiirmenüüst korraldus Save Target As....  
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Seejärel avaneb aken: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Valige salvestamisekoht (Save in), failinimi (File name) ning kinnitage 
nupuga Save. 
 

 

Kuidas salvestada oma arvutisse olemasolevat internetilehekülge? 
 
Iga vaadatava veebilehe sisu saab säilitada, salvestades selle failina arvuti kõvakettale.  

1. Valige menüüst File -> Save As 
2. Näidake ära salvestamise koht (nt Desktop), andke failile nimi ja vajutage „Save“ 

Failitüübiks on vaikimisi „Web Page, complete“, see tähendab, et kõvakettale salvestatakse kogu 
veebileht (tekst koos graafiliste objektidega; graafilised objektid salvestatakse omaette kausta) 
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Kuidas salvestada oma arvutisse internetileheküljel olevat teksti? 

1. Valige menüüst File -> Save As,  ilmub dialoogikast: 

 

2. Näidake ära salvestamise koht (nt Desktop), andke failile nimi ja valige faili tüübiks ()  Text 
File (*.txt) 

3. Vajutage Save 
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Kuidas salvestada oma arvutisse internetileheküljel olevat 
pildimaterjali? 
 
Valige pilt, mida soovite salvestada. 

 klõpsuta hiire parempoolse nupuga joonise peal, et ilmuks kontekstmenüü 

 valige korraldus Save Picture As (või "Save image as..."), et kuvada dialoogikast Save 
Picture 

 
 

 
 

 valige kaust, kuhu joonist faili kujul salvestada (vaikimisi „My Picture“) 

 valige failile nimi 

 klõpsake nupul Save 
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Internet Exploreri kiirklahvid 

Te saate kasutada Internet Exploreri kiirklahve, et sooritada paljusid erinevaid toiminguid kiiresti või 
töötamiseks ilma hiireta. 

  

Järgnev tabel kirjeldab kiirklahve, mida kasutatakse veebilehtede vaatamiseks ja uurimiseks. 
 

Selle tegemiseks Vajutage seda 

Brauseriakna täisekraan- ning tavavaate vahel liikumine F11 

Liikumine avalehele ALT+HOME 

Liikumine eelmisele lehele  BACKSPACE 

Kerimine dokumendi alguse suunas ÜLESNOOL 

Kerimine dokumendi lõpu suunas ALLANOOL 

Suuremate ühikute kaupa dokumendi alguse suunas kerimine PAGE UP 

Suuremate ühikute kaupa dokumendi lõpu suunas kerimine PAGE DOWN 

Dokumendi algusesse hüppamine HOME 

Dokumendi lõppu hüppamine END 

Aktiivselt lehelt otsimine (Find funktsioon) CTRL+F 

Aktiivse lehe värskendamine F5 

Lehe allalaadimise katkestamine ESC 

Uue veebisaidi või lehe avamine CTRL+O 

Uue akna avamine CTRL+N 

Aktiivse akna sulgemine  CTRL+W 

Aktiivse lehe või paneeli printimine CTRL+P 

Lemmikute avamine (Favorites) CTRL+I 
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Ajaloo avamine (History)  CTRL+H 

Tipitud aadresside loendi kuvamine   F4 

Tipitava teksti algusesse "www." ja lõppu ".com"  
lisamine aadressi- ribal    CTRL+ENTER  

 

    Muudab aadressiriba valituks                    F6 

Aktiivse lehe lisamine lemmikutesse                  CTRL+D 

Dialoogiboksi „Korralda kausta Lemmikud sisu“ avamine                   CTRL+B 

   Menüü Lemmikud avamine menüüribalt                                ALT+A 

Valitud üksuste eemaldamine ja lõikelauale kopeerimine   CTRL+X 

Valitud üksuste lõikelauale kopeerimine   CTRL+C 

Lõikelaual asuvate üksuste kleepimine valitud asukohta   CTRL+V 

Kõigi aktiivse veebilehe üksuste valimine   CTRL+A 

Brauseri akna sulgemine    Ctrl+F4  
 
  
 

 


